
Laser Cutter Guide
This guide is limited to the basics of the library’s Epilog Mini 12”x18” laser engraver. After you are
trained, we encourage you to read the full laser manual starting with section 7 and then seek out
tutorials and projects that interest you to further develop your skills. Email us at
makerspace@estesvalleylibrary.org if you need advice on whether a project is possible on our laser
cutter.

Laser Basics
People refer to these machines as either “laser cutters” or “laser engravers”, but they can do both!
These two modes are called raster engrave and vector cut

raster engrave - engrave photographs, shapes, and text into
the top layer of a material
Speed and power settings determine the depth and color of the
engraving. Some materials darken when engraved (sometimes
dramatically) and some do not. Image resolution also affects color
and depth- an image engraved at 600 DPI has twice as many dots as
one engraved at 300, and will look sharper, build up more heat and
remove more material.

vector cut - cut a thin line all the way through a material
Generally, our laser can cut materials up to ¼” thick. Speed and power
settings determine the depth of the cut, while frequency affects how
much heat builds up on the material. Low frequency is desirable for
materials like wood and paper that can char, while high is best for
materials like acrylic where melting creates a clean edge.

Combined Mode
In combined mode the laser will raster engrave first and vector cut
second.
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Bad Laser Materials
Adapted from ATXhs.org  | Always positively identify your materials before cutting

PVC (polyvinyl
chloride), including

vinyl and
pleather/artificial

leather

Emits noxious chlorine
gas when cut!

Don't ever cut materials containing chloride as they
release chlorine gas that will corrode the inside of the

laser, damaging the optics and motion control
system. It’s bad for people too! If you aren’t sure your

material doesn’t contain chlorides, don’t cut it!

Polycarbonate/Lexan
Cuts poorly, discolors,
damages laser optics

Although it might look just like acrylic, polycarbonate
absorbs the laser’s light frequency, causing

discoloration and poor cutting performance. The
inefficient cutting process creates stringy soot that

can coat and damage the laser optics.

ABS
Cuts poorly, melts,

catches fire, emits fumes
ABS cuts and engraves poorly on a CO2 laser. It tends
to melt rather than vaporizing, creating ugly cut edges

and risking fire. It also emits noxious fumes.

Polystyrene Foam Catches fire Catches fire quickly and burns rapidly. Polystyrene
foam is the #1 cause of laser fires!

Polypropylene Foam Catches fire
Like polystyrene, it melts, catches fire,

and the melted drops continue to burn and turn into
rock-hard drips and pebbles.

Epoxy Emits noxious fumes
CO2 lasers can't cut through it, and attempting to cut
it releases toxic fumes. Items coated in epoxy or cast

epoxy resins should not be used in the laser cutter.

Fiberglass
Can’t be cut, emits

noxious fumes
It's a mix of two materials that can’t be cut. The laser
can’t cut the glass fibers, and the epoxy resin can’t be

cut AND releases fumes

Coated Carbon Fiber Emits noxious fumes Thin carbon fiber mat can be cut,
but not when coated with epoxy

Material with “PSA”
glue backing

Damages laser optics
Otherwise suitable materials like wood veneer

create sticky soot that can damage the laser optics
if they have a “PSA” glue backing. Please do not cut

sheets of material that have a PSA backing.

Polyethylene
(HDPE & LDPE)

Cuts poorly, melts
Plastics commonly found in packaging materials

(milk bottles, butter tubs, etc). It melts and
becomes gooey and waxy, with messy edges

2



Good & OK Laser Materials
● Always positively identify your materials before cutting

● Bring extra materials and plan to test your settings before working on your project

● Check the laser binder for recommended settings

● Our laser cannot cut metal, no matter how thin! See the next page for ways to engrave

on metal

Cut & Engrave

Acrylic/Plexiglass
Cuts beautifully! One of the best materials for laser cutting.
We buy our acrylic from estreetplastics.com. Cast acrylic engraves better than
extruded acrylic, so look for “cast” in the product description if you’re buying for
an engraving project.

Specialty laser plastics
& sheet materials

Check the “Laser” section of online engraving suppliers like jpplus.com for
plastics and other sheet materials specially selected for laser use, including
two-layer plastics for high-contrast engraving

Wood

Baltic birch plywood, alder, and cherry give especially nice results and white
pine, oak, and balsa are also recommended. Woods with a tighter grain make
for clearer engravings, but wood with a bold grain can give an interesting artistic
result. Plywood is more difficult to cut than solid wood and our low-power tube
will  struggle with plywood sheets thicker than about ⅝”. Test on different
woods before pursuing a large project to make sure you like the results. Wood
specially selected for laser cutting can be purchased from engraving suppliers
like jpplus.com.

Eucaboard brand
hardboard

Eucaboard by Eucatex is a common brand of high-density fiberboard that cuts
and engraves beautifully in the laser and contains no glues (it’s made entirely of
eucalyptus fiber), so no worries about releasing fumes. Check the back of HDF
sheets at Home Depot, Lowes etc for this brand to guarantee an excellent laser
experience.

Paper & Cardboard
Cardboard is a great material for the beginner laser cutter enthusiast since it’s
cheap or free! It cuts better than it engraves. The laser cuts even delicate paper
beautifully at low power levels- use the solid vacuum table and magnets or tape
to hold the paper down.

Fabric The laser can cut both synthetic and natural fabrics on low power levels.
Use the solid vacuum table with magnets or tape to hold it down.

Taskboard
Taskboard is a dense, solid paper product about halfway between cardstock
and balsa wood. It engraves and cuts beautifully. Highly recommended for craft
projects. Commonly used for architectural models. Available from
taskboard.com
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Leather Leather engraves and cuts nicely, but it doesn’t smell very good.

Cork
Cork cuts easily and is also very rewarding to engrave, creating a clear and crisp
black mark even on low power settings. Avoid cork with a PSA (pressure
sensitive adhesive) backing which can create sticky smoke that is hard on the
laser optics.

Engraving Only

Painted & coated metal

The laser cannot cut or mark metal (not even foil!), but it CAN mark or remove
surface coatings from painted or coated metal. Painted steel water bottles and
other drinkware give nice results, especially on the rotary, as does anodized
aluminum. Several passes may be required to remove the coating completely-
bring a spare item to test on! Metal sheets pretreated with a “Ceramark” coating
work great for engraving- check engraving suppliers like jpplus.com for
Alumamark/Ceramark or “laserable metal”.

Promotional items

Promotional items like keychains, coasters, wallets, jewelry boxes, etc are
sometimes engraveable. Browse an engraving supplier like jpplus.com and
follow their recommendations for best results. Never engrave unknown
materials, especially plastics! You must be able to positively identify the
specific  material before engraving it (for example, alder, acrylic, anodized
aluminum, painted steel- not just “wood” or “plastic”!)

Glass

Glass can be engraved with good results. Colored glass tiles are a great place to
start. Rounded objects (bottles, wine glasses, Christmas ornaments) can be
engraved either by propping them on the flat table, or on the optional rotary
attachment. The rotary is best for intermediate to advanced laser users who are
ready for a challenge.

Ceramic Tile Works great, especially darker tiles with a lighter center. The laser will remove
the top layer and expose the interior ceramic color.

Stone
Stone can be marked with high power settings and several passes. Slate gives
especially good results and smooth river stones can be interesting, if
unpredictable.

Have a project idea? Wondering if your material can be cut or engraved?
Please email makerspace@estesvalleylibrary and we will help you evaluate your material
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⚠ Laser Safety, part 1
● Never leave the laser unattended.

Do not leave the room during a cutting job, no matter how long. Remain within arm’s reach of
the laser and fire extinguisher during any job, and monitor the laser beam during vector
cutting, which is much more likely to start a fire.

● Use proper ventilation
The laser has two ventilation systems- a large exhaust fan to the outside, and a small air
assist pump that blows debris away from the cut area with a strong stream of air. The laser
also has its own fan that works with the exhaust.

○ The exhaust is on during all jobs. The Laser/Exhaust switch powers both the laser
and the exhaust fan.

○ Use the Air Assist when vector cutting.
The air assist pump blows a directed stream of air that keeps the cut area cool and
free of flammable debris and makes your cut cleaner. Air assist is not necessary for
raster engraving-only jobs, but it doesn’t hurt, either.

○ When using the laser, close all windows in the Makerspace and close the doors
■ Don’t “air out the room” by opening windows when cutting- prevailing winds will

blow the exhaust back inside.
■ Closing the Makerspace doors will help the exhaust fans work efficiently by

pressurizing the room and will keep Computer Commons users from being
disturbed

■ If your material has a strong smell, take occasional breaks while leaving
Laser/Exhaust on so the fans can work to clear the room

● Know your material. Never cut unknown materials.
Materials containing chlorides (like PVC plastic sheets and vinyl/faux leather) release
poison gases that can permanently damage the laser and even injure people. Several other
materials are poor choices for laser cutting. Review the Bad and Good lists of laser
materials when planning your project.

● Use care when moving items from the laser.
Laser cut objects usually cool quickly, but there is always a chance of heat or flame
on cut edges.

● Eye safety
The high-power cutting laser beam is contained in the cabinet and cannot hurt you. Although
it is very tempting to watch the beam during cutting, it can cause non-permanent
afterimages much like a camera flash, so stare sparingly.

● Laser safety interlock
Raising the lid during a job will turn off the laser beam, but the X/Y motors will continue
running. Plan to pause jobs before raising the lid.
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🔥 Laser Safety, part 2: In Case of Fire
● Lasers can and will start fires! Vector cutting is much more likely than raster engraving to

start a fire. Always monitor vector cuts, and stay within arm’s reach of the laser control
panel and the fire extinguisher even during raster engraving. See the list of Bad materials
and avoid materials that are more prone to burning.

○ Sparks or brief flame: Monitor the job carefully and note if the flame goes out when
the laser moves away from the area. Brief flames may mean a poor quality cutting
job. If your job seems to be creating frequent flame, try restarting the job at a lower
power level or higher speed.

○ Small sustained flame (think birthday candle): Pause the job, open the lid and either
blow out the flame or douse it with a damp cloth. Stop the job with Reset and restart
with a lower power level/higher speed.

○ Large flames contained within laser enclosure: Pause the job or turn off the laser,
then follow instructions on the Makerspace fire extinguisher. The fire extinguisher in
the makerspace is a special formula that will not damage the laser

○ Flames outside laser enclosure: Notify staff immediately. More fire extinguishers and
fire alarm pull boxes are located in the hallway next to the elevator and by the 2nd
floor emergency exit (southwest corner of the second floor, opposite and to the right
of the makerspace doors)
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Setting up your artwork in Illustrator
Creating laser artwork in Illustrator is a big topic! Below are the steps for a basic job.

Creating a new document
● Open Adobe Illustrator
● Use the Create New button or go to File > New

○ If you are using a sheet of material (like a piece of cardboard or acrylic), you will want
to make a document the same size as your entire material piece and place your
designs exactly where you want them to appear on the material sheet.

○ If you are using a small or irregularly sized item like a coaster, you can instead make a
document the same size as your design. In a later step, you will manually position the
design on your item

● In this New Document window, set the units to Inches and the height and width to your
material or design and click Create
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Setting up your artwork in Illustrator, continued
Example project
For my example project, I will engrave some text and then cut it out as a round tag shape

1. The Illustrator workspace
First, I’ll make sure I have all my useful Illustrator panes open by going to Window > Workspace >
Reset Laser Workspace (The Makerspace laser computer has a custom “Laser Workspace” already
set up). This will open the Properties, Layers, Swatches, Align, and Pathfinder panes.

2. Making shapes
○ Choose the Ellipse tool (click the little

arrow in the bottom right corner of the
Rectangle tool to see all the shapes)

○ Click and drag while holding Shift to
make two circles, one small and one
large. (Holding Shift keeps your circle
circular, rather than making an oval)
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3. Selecting and nudging
○ Now I choose the Selection tool (black arrow). There are a few ways to select objects:

■ Click on each circle to choose them one at a time
■ Hold Shift and click on one circle and then the other to select both
■ Click and drag over both circles to Box Select both at once

○ Once I have a shape selected, I can either drag it to move it, or nudge it with the keyboard
for more precision
■ Use the arrow keys for a tiny nudge
■ Hold shift and use the arrow keys for a bigger nudge.

○ Select the small circle and nudge it near the top of the big circle

4. Aligning
○ Now we can use the Align pane to line up the small circle and the big circle so we know it’s

perfectly centered.
■ Use the Selection tool to select both circles (either click and drag to Box Select, or hold

shift and click each of the circles)
■ In the Align pane, in the “Align to:” dropdown, you can leave Align to Selection selected,

or change it to Align to Artboard so the circles are aligned to both each other and your
piece of material

■ Choose the Horizontal Align Center button.
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5. Stroke width
With both circles selected, in the Properties pane, set the line width to 0.08 pt (you will type it in
rather than finding it in the dropdown)
0.08 pt (or 0.001 inches, or 0.025 mm, if you’re using those units) is a very special line width.
The laser will interpret any line this width as an instruction to vector cut a smooth line through
the material. Any line or area thicker than 0.08 pt/0.001 in/0.025 mm will be raster engraved.
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6. Text tool
Find the Text tool. Click and drag to make a text box. Type your text and change the font and
size if needed in the Properties pane. Drag the edges of the text box with the Selection tool
to line it up where you want it on your tag. Because this text is solid black, not outlined with a
0.08 pt stroke, it will be engraved rather than cutting through.

Now you’re ready to engrave and cut this design!
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Getting the laser ready
Power On

Turn on the Laser/Exhaust
switch under the counter. You
can also turn Air Assist on
now if you like.

If the laser doesn’t come on,
check that the large switch
near the plug on the lower rear
part of the right side is flipped
to | (on)

The laser will boot up and you
will hear the X and Y axis
motors checking their home
position

Control panel
The buttons you’ll usually use on the front panel of the Epilog Mini are Go, Pause, Reset, Set Home,
X/Y Off, Red Dot Pointer, Maintenance, Focus, and the Up/Down arrows
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Vector grid and vacuum hold-down table
Change tables if needed. Generally, you can use the vector grid, which looks like a honeycomb.
Tables are kept in cabinet 10.

Use the vector grid for vector cutting or raster
engraving on materials that are heavy enough that
they won’t blow around.

The open grid minimizes scorch marks on the back
of your material caused by the laser beam bouncing
off the metal.

Use the vacuum table (solid with small holes) for
engraving/cutting on light materials/objects that
need suction, magnets, and/or tape to stay in place.

The more holes in the table are covered, the more
the light material will be held in place. You can cover
any exposed holes with scrap material or use the
magnets on the whiteboard and/or blue tape to hold
your light material in place if needed

To change the table
● Press the Focus button and use the up/down buttons to lower the table a few inches.
● Flip up the spring-loaded rulers on the left, top, and right sides of the enclosure
● Load the table (vector grid with its metal rim down, vacuum table shiny side up), and flip the

rulers down
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Where to place your material
Option 1: Starting from the top left corner (easiest, good for sheet materials)

1. When making your design, set your document (artboard) size to the same size as your entire
piece of sheet material, and place the design where you would like it to appear on the sheet.

2. When loading your material, slide it snugly against the rulers at the top left corner of the
table. That’s it!

Option 2: Starting from the center-center position (good for small or irregularly
shaped objects/materials):

Center-center engraving
Unlocking the X/Y axis, lining up X and Y on a pencil
mark using the Red Dot Pointer, and setting the new
home position. Now the laser will center my design
on the pencil mark instead of starting from the top
left corner of the bed.

1. When making your design, set your document (artboard) size to be around the same size as
your design. For example, you might make a 3” wide, 2” high design to go in the middle of 4”
diameter round coaster

2. Use a ruler to identify the center of your item and mark it with a pencil dot (or guess!)
3. Place your item anywhere on the bed

On the control panel, press 4. Red Dot Pointer, then 5.  X/Y Off, then 6. Go to confirm
4. Move the X-Y carriage with your hand (the X axis is a small silver head, and the Y is a large

blue bar that spans the laser chassis) until the red dot pointer is in the center of your object.
On the control panel, press 8. Set Home, then 9. Reset to go back to the job list.
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Using the center-center position: When finished
When finished with your Center-Center engraving job, reset the home position for the next user:
On the control panel, press Maintenance and then the down arrow, then choose 1. Restore Home
and press Go.

Focus
Autofocus
A good choice for most flat materials. A plunger on the laser carriage will tap your material surface
to measure distance before starting the job. You won’t have to change anything on the laser control
panel if you choose autofocus- you’ll just select Auto Focus in the Laser Dashboard during printing.

If you are running many jobs on the same material, you can leave Auto Focus unchecked after the
first job has run Auto Focus. The laser table will not move out of place until it’s focused again.

Do not use autofocus on bumpy objects or sheet materials that already have holes cut out- hitting the edge of
a hole or lump can fold the autofocus plunger over and jam the x-axis.

Manual focus
Good for small or unusually shaped items or soft surfaces, situations where you want a little extra
certainty, or would prefer the autofocus plunger not touch your material (which could move it)

1. Place the focus gauge onto the laser carriage. A magnet on the carriage holds it in place.
2. Press Focus on the control panel, then use the control panel’s up/down arrows to

raise/lower the table until the material surface just barely touches the focus gauge. It
doesn’t have to be perfect. If you lower the focus gauge into the material, it will move up
without hurting anything and eventually pop off the magnet.

○ If your material is curved, select a medium distance between the high and low points.
○ If there is more than 3mm of variation in your surface, parts of your engraving may

look fuzzy and the beam might not cut all the way through during vector cutting (the
more out of focus the beam is, the weaker it is)

3. You will uncheck Auto Focus in the Laser Dashboard during the printing step.
4. Press the back arrow (button 0) on the laser panel to exit focus mode.
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About warming up the laser tube and testing
For every new laser project, plan to test first with a piece of scrap material or run a small job on
one corner of a material sheet.

● After sitting for a few hours, the laser tube needs a chance to warm up to full power. About
45 seconds of engraving or 5 seconds of cutting is enough to bring the tube up to full power.
You will know it’s ready when you see a visible beam.

● If you have a valuable material or a limited number of pieces, you will want to dial in your
settings with several tests. The tables of material settings in the binder and the laser manual
are just starting points

● Test on your real material if you can. If you have no extra material, use a bit of cardboard.
Cutting on cardboard won’t give you much information about your power settings, but it will
warm the laser tube up.
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Running your job
Setting up your job in the Laser Dashboard

● Go to File > Print and click Setup in the lower left corner. This will pull up a list of printers.

● Select Epilog Engraver X64 Ethernet, then Preferences to open the Laser Dashboard

● Set Piece Size first and exit the dashboard to apply the setting (Illustrator
glitch)

○ Set the Piece Size to the same size as your Illustrator document, then click OK, then
Print.

○ Click Setup again and then Print again and you should see the Media size in the lower
left hand corner of the Illustrator print window change

○ Now you can do Setup > Epilog Engraver X64 Ethernet > Preferences once more and
set the rest of your preferences.

● Resolution
○ Between 600 and 300 DPI is good for photos. Refer to the materials tables for

example settings. Epilog manual page 63 has other tips for choosing DPI. You can
leave this setting wherever it happens to be if you are doing a vector-only job.
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● Job Type
○ Make a habit of selecting either Raster or Vector unless you’re doing a job that

requires both- then choose Combined.
● Raster Setting (if you’re raster engraving)

○ Speed/Power: Refer to the materials tables and page 143 of the laser manual for your
raster speed and power settings. You can either type a value or use the -/+ buttons
and/or slider to adjust.

○ Engrave Direction: Choosing bottom-up engraving can prevent soot from being drawn
into the nooks and crannies of your raster design, which is especially noticeable on
light materials like paper.

○ Image Dithering: Refer to page 77 of the laser manual for advice on which dithering
settings are best for which application. When in doubt, choose Standard.

● Vector Setting (if you’re vector cutting)
○ Speed/Power/Frequency: Refer to the materials table on page x for your vector

speed, power, and frequency settings. You can either type a value or use the -/+
buttons and/or slider to adjust. (Adjust frequency using the buttons or slider.)

○ Vector sort: Optimize works for most cutting jobs, while inside-out is preferred for
jobs where small interior details need to be cut first.

○ Frequency automatic: Leave unchecked
● Options:

○ Auto Focus: If you used the manual focus gauge when loading your material, uncheck
Auto Focus. If not, check it.

○ Center-Engraving: If you loaded your material in the center-center position and set a
new home, check Center-Engraving and choose Center-Center from the dropdown.

○ Send to Laser/Send to Manager: Keep both of these checked.

Ready to go
When ready, click OK, then Print, then Print again. This will queue the job on the laser, but it won’t
start until you press the Go button on the control panel.

Quick check before starting the job
● Is the exhaust fan on?
● Is the air assist pump on if needed?
● Did you warm up the laser tube?
● Is your material loaded?

The LCD screen on the laser will display your job name. (The job sent from the computer most
recently will be the one displayed)

● Press the green Go button on the laser to start the job.
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During the job
● Stay within arms reach of the laser during engraving, and watch the job during cutting.
● Follow the Laser Safety: In case of fire instructions if you see flames
● To pause the job, use the red Pause button. Resume with the green Go button.
● To end the job, use the red Pause button and then the black Reset button.

When done
● Remove any debris from the bed
● Pull very hard on one front access door handle to open it, then flip out the two latches on the

crumb tray, slide it out, dump it, and replace it.
● Turn off the laser, the Laser/Exhaust switch, and the Air Assist pump switch.
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Material Settings
These are initial power settings for common materials. Bring extra materials for testing and plan to
adjust your settings further.

Engrave/Raster Cut/Vector

Material Speed Power DPI Frequency

Wood

Engrave photos* 40 100 600 DPI

*Note: Plan to experiment with the dither settings to get the most appealing results on your
material

Engrave text/clipart (high resolution) 30 100 600 DPI

Engrave text/clipart 25 100 300 DPI

Cut veneer 30 22 Freq. 500

Cut ⅛” (3mm) 25 100 Freq. 500

Cut ¼” (6mm) 8 100 Freq. 500

Acrylic

Engrave photos 90 60 300 DPI

Engrave text/clipart (high resolution) 90 80 600 DPI

Engrave text/clipart 90 75 300 DPI

Cut ⅛” (3mm) 9 100 Freq. 5000

Cut ¼” (6mm) 5 100 Freq. 5000

Other plastic

Engrave general plastic 90 40 300 DPI

Engrave two-layer plastic (high resolution) 90 70 600 DPI

Engrave two-layer plastic 90 80 300 DPI

Cardboard

Cut single layer 50 50 Freq. 500

Cut double layer 30 70 Freq. 500

Engrave (light mark) 100 15 300 DPI
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Copy paper

Cut 100 15 Freq. 1000

Material Speed Power DPI Frequency

Eucaboard brand hardboard

Cut 12 100 Freq. 500

Engrave 30 100 600 DPI

JPPlus Laserable Alderwood

Cut (⅛”) 25 100 Freq. 500

Engrave 30 100 600 DPI

Taskboard

Cut (1/16”) 50 50 Freq. 500

Engrave 100 60 300 DPI

Slate Coasters

text 90 65 600 DPI

photo 90 55 300 DPI

Cork coaster

Engrave 90 50 600 DPI

Other materials

Painted steel water bottle* (engrave only)
*Our bottles had thin paint- bottles with a Yeti-like
textured coating may need more power

60 50 600 DPI

Leather ⅛”

Engrave text 70 60 600 DPI

Cut (⅛”) 20 80 Freq. 600
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Intermediate Tutorial: Image to Vector
with Image Trace
Just about any image can be raster engraved on the laser, but to cut all the way through a material,
you will need to give the laser vectors, also known as paths. During a vector cut, instead of making
rows of dots as it does during raster, the laser will smoothly follow the path, creating a cut line
that’s only as wide as the laser beam.

Option 1: Start with a vector file
You can skip the tracing step by starting with a vector file. Vector files are a bit harder to find online
than other kinds of clip art and sites often charge a few dollars to download a package of vector
images. Vector files typically have an .ai, .eps, or .svg extension. Even if it seems like you’re
downloading a vector file, you’re sometimes only getting the raster preview image, which will not be
cuttable without tracing. Vecteezy.com is a stock vector site. Designs without the “pro” label are
free to download. The Noun Project is also a fun place to look for free, simple vector files
thenounproject.com When you open the file in Illustrator, you should be able to click on parts of the
illustration with the Direct Select tool and see blue paths outlining the shapes.

Option 2: Select a traceable image:
The image to trace should have few colors (black and white is best) and simple forms. A
photograph can be successfully traced, but it won’t be cuttable. Try googling for “border collie
silhouette” or “border collie clip art” rather than just “border collie”, and when selecting an image,
choose the one with the highest contrast and the fewest colors. You can also Desaturate and
adjust the levels on your image in Photoshop first. (Also- psst! You are responsible for following
copyright law!). Copy the image or save it to the computer.

This clip art will make an excellent cut path- it has a pure white background and solid filled shape

22



Image Trace
1. File > Place or paste an image onto the artboard.

○ The higher resolution the image, the more accurate the trace.
○ It’s OK if the image hangs off the sides of the artboard during the trace

2. Click the image to select it, then open the Window > Image Trace pane.
Use the following settings:

○ Preset: Default
○ View: Outlines with Source Image
○ Mode: Black and White

■ If you are going to raster engrave your trace rather than cutting it, you can try the
other two modes too

3. Zoom in so you can see the relationship between the image and the outlines.
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Image Trace, continued
4. Open the Advanced settings:

○ Tweak the Threshold, Paths, Corners, and Noise sliders until you like the way the
outlines follow the image.

■ Noise and Threshold affect where the line falls relative to the pixels
■ Paths and Corners increase the number of points in the trace, which will make

your design cut more slowly, but it will be more accurate (which can also look
overly jagged, so slide it until it looks the way you like)

5. Choose the Method.
○ For most cases, Abutting with Ignore White checked is the best choice.

6. When ready, uncheck Preview and press Trace or go to the Object menu > Image Trace >
Expand

Finishing touches
1. Ungroup. All the shapes in your trace will be one group. Right-click and choose Ungroup. You

may have to Ungroup a few times to free all the shapes.
2. Delete unwanted shapes. Select shapes you don’t need (using either Direct Select (black

arrow) or Select (white)) and use the Delete key.
3. Regroup. Box-select and Right-click > Group shapes that need to stay together.
4. To make your trace cuttable, box-select all the wanted shapes and set them to Fill: None

and Stroke: 0.08pt Solid Black in the Properties pane.
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Advanced Laser Training:
Using the Rotary Attachment
Step 1: Remove the vector grid and crumb tray and install the rotary

1. Lower the table slightly. Power the laser on. Using focus mode, lower the table a few inches
so you have room to flip the rulers up.

2. Remove the vector grid. Flip up the spring-loaded left, top, and right rulers and lift the vector
grid up and out. Set aside.

3. Remove the crumb tray. Open the front door (pull very, very hard on just one of the handles).
Flip the crumb tray latches outward and slide the crumb tray out. Set aside.

4. Lower the table completely. Using focus mode, lower the table all the way down.
5. POWER OFF. Never plug in the rotary when the power is on.
6. Position the rotary. With the wheels on the left side, align the 3 pins of the rotary with the 3

holes on the bottom of the laser (the right hand pin is out of sight under a little cutout on the
frame)

○ When handling the rotary, try not to touch the rubber tires
7. Plug the rotary in. Leave the power off for now.

Parts of the rotary
● The drive wheels on the right side are motorized and spin your object
● The support wheels on the left side roll with the object and can be raised up and down to

make the surface of your object level. If your object has a narrow side, place it on these
wheels.

● Push the left side of your object against the bumper.
The bumper is the start point of the
engraving.

● Flip the release lever toward the front
of the laser to slide the support wheels
right. Flip it back to lock.

● Use this knob to raise and lower the
support wheels to level your object
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Step 2: Place your object on the wheels and level it
1. Examine your object and decide how to place it on the wheels.

○ The rotary attachment has a scissor jack that can lift the right side of your object, so
you’ll want to place the side that needs lifting, usually the smaller side, to the right.

○ You can also place both sets of wheels under a straight/flat section of your object
rather than under the far end.

2. Adjust the spacing between the tires.
○ Flip the silver release lever toward the front of the laser and slide the support wheels

to the right until the space between the wheels is the right width for your object. Flip it
back to lock.

3. Place the object on the tires.
○ Push the object against the black tab/bumper on the left side of the rotary. This

bumper is the start point for the engraving.

4. Level the object.
○ Use a level from the pegboard and compare the frame of the laser to the top edge of

your object, then rotate the scissor jack knob to raise/lower the right side if needed.

5. Turn the laser on.
○ With the rotary plugged in, the laser will automatically set the home position to the

black bumper (X 0, Y at the centerline of the rotary)

Step 3: Manual focus
1. Put the focus gauge on the pegs on the X-axis and choose Focus Mode.

a. In focus mode, the X and Y axes are released, so you can move the x-carriage side to
side to find a good spot to focus on if needed.

2. Use the arrow keys to raise the z-axis/table until the gauge touches your item.
3. Exit focus mode with the Back/Reset button
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Step 4: Create a document and position your design
1. In Adobe Illustrator, use Create New to make a document the same size as

your object.
○ Document width: length (right to left) of the object when it’s horizontal, starting from

the left side
○ Document height: Distance from your starting point to the end of your design

2. Refer to the examples on the next page for tips on how to position your design on the
document.
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Step 5: Print
● Refer to the Laser Cutter training for full printing instructions, with these special

considerations:

○ Resolution: Use 300 DPI for glass- higher DPI settings get flaky/melty
○ Job Type: Will be Raster in most cases
○ Raster Setting:

■ Image Dithering: Jarvis is recommended for glass
○ Options:

■ Auto focus should be unchecked
■ Center-Engraving should be unchecked

○ Page Size: Same as your document- width is the object length, height is the object
circumference

● The laser automatically detects the rotary and knows to spin the object rather than moving
the Y axis.

● Remember to warm up the laser tube on scrap material (use your own test object, or use a
scrap bottle from Cabinet 10). You don’t need to relevel or change focus, just look for a
visible beam.

● Use the material settings from the material tables.

● Especially when using the rotary, run the job with the lid up and the red dot pointer on to
confirm that the object is stable on the wheels and that the laser is traveling to the area you
want to engrave. Then run again with the lid down.
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Glass Tips
● When removing glass, do not touch the engraved area when removing the item. Rinse the

engraving under water with a scrub pad to remove the glass powder.
● Try changing the fill color of your design to 80% gray (that’s the third gray from the left in the

Illustrator Swatches panel. Hover over the swatches to see the K percentage) rather than
using pure black

● Use the Jarvis rather than the Standard dither for a frosty appearance
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Troubleshooting
My job is showing up on the
front panel of the laser but
when I press Go, it just beeps
and then says Done without
cutting/engraving

● Check that your job type is right for your job (vector for
cutting, raster for engraving, combined for both)
○ If your job is Combined, try running it first as vector only

and then as engraving only to help diagnose the
problem

● For vector cutting jobs, check that your line:
○ is a vector line (click with the white Direct Select tool

and make sure you can you can see a path, points, and
handles)

○ Is the right width (0.08 pt/0.001 in)
○ Is the right color (#000000, solid black)
○ Is aligned to the center of the path. In the Properties

pane, click the word Stroke and check that Align to
Center is selected rather than Inside or Outside, and
that Dashed Line is unchecked

I’m running a vector job and the
laser is cutting, but not all the
way through

● Check focus
● Check line width and color (0.08 pt, solid black)
● Let makerspace@estesvalleylibrary.org that the laser

optics may need to be inspected and cleaned

I’m engraving a photo or
complex illustration and it
doesn’t look very good

● For a really nice photo engraving, plan to dedicate a
generous piece of scrap material (same as your intended
final material) and run 4 or more test jobs to get your
settings just right
○ Try different dithering modes during your test jobs.

Refer to Chapter 13 of the full laser manual for advice.
● Open your image  in Photoshop first, Desaturate it, and

then use Levels and/or Curves to make your whites whiter
and your darks darker

● A DPI of higher than 300 can cause a stripey, uneven
appearance on glass and acrylic due to the densely placed
dots melting the material unpredictably. If you want a very
high-resolution look on acrylic or glass, plan to run it at a
lower than recommended power and try running it more
than once.
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Oh no! The autofocus plunger
folded over and it looks broken,
and the laser says it is jammed!

First, don’t panic, the autofocus plunger is spring loaded and
it can fold over without damage. You will need to manually
lower the table so the laser can check its x and y axis during
startup without getting caught:

1. Turn off the laser
2. Pull very, very hard on ONE of the handles on the front

door of the laser
3. Grab the first belt you see running along the bottom of

the laser’s case and pull it to the right to slowly lower
the table. You’ll probably have to pull on the belt a few
times to get the bed low enough that the autofocus
plunger is no longer folded over.

4. Close the door and turn the laser on. It should be able
to run through its normal setup process.

In the future, avoid using Auto Focus with bumpy, uneven, or
oddly sized materials, or material sheets with holes in them. If
the autofocus plunger touches down at an angle, it can fold
over.
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I’m trying to start a job but the
laser seems like it’s starting
somewhere in the middle of the
bed.

Check that someone didn’t accidentally set a new home
location during center-center engraving and then forget to
reset it: On the control panel, press Maintenance and then the
down arrow, then choose 1. Restore Home and press Go.

The laser starts in the top
corner of the bed, but it’s
putting my design in the wrong
place

Make sure your Piece Size in the Laser
Dashboard is the same size as your
Illustrator document. If not, set the
Piece Size in the dashboard, click Print,
then open Setup again and click Print
again (this is a glitch in Illustrator). You
should see your Document and Media
size (bottom left corner of the
Illustrator print pane) are the same.

On the right, my Document (Illustrator
artboard) and my Media (called Piece
Size in the Laser Dashboard) aren’t the same. I might have
forgotten to set Piece Size, or I might need to click Setup again
and then Print to get past the Illustrator glitch.

If your piece size and document size are the same, check that
your design wasn’t auto rotated in illustrator.

Below, my Document size and Media size are both right, but
under Orientation my design is rotated 90 degrees. I should
click the first button under Orientation to get my design going
the right direction.
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